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This manual provides instruction on using EPA’s State Greenhouse Gas Projection Tool 
(hereafter referred to as the Projection Tool).  It contains detailed guidance on 
employing the Projection Tool to project greenhouse gas emissions at the state level 
for the time period from 2022 to 2050.  Estimates generated in the Projection Tool are 
extrapolated from historical emission estimates obtained using methods and data 
sources consistent with EPA’s Emission Inventory Improvement Program Volume VIII: 
Estimating Greenhouse Gas Emissions (hereafter, State Guidance), a guide for states 
conducting greenhouse gas emission inventories.1 
 
This guide to using the Projection Tool is organized as follows: 
 
1.1 Introduction to the Projection Tool 

1.2 Using the Projection Tool 
1.3 Frequently Asked Questions 
1.4 For More Information 

 

1.1 INTRODUCTION TO THE PROJECTION TOOL 

The Projection Tool was designed as a companion to EPA’s State Inventory Tool (SIT), 
which estimates state-level emissions for 1990 to 2021.  These tools can be used 
either in conjunction with, or independently of, one another.  Users who have 
completed the historical emission estimation process using the SIT can import the 
historical emissions into the Projection Tool to obtain a complete time series of 
emissions from 1990 through 2050.  In some instances, SIT estimates can also be 
used as a basis for 2022 to 2050 projections.  Users who have not used the SIT to 
estimate historical emissions can still project emissions for some sectors, although 
creating a historical timeline of emissions by sector using the SIT is preferred.   

Both the Projection Tool and the SIT are based on EPA’s Emissions Inventory 
Improvement Program’s (EIIP) State Guidance.  Due to the limitations inherent in 
estimating future emissions and the need to contain all sectors in a single workbook, 
the Projection Tool does not present the calculations in the easy-to-follow and 
instructive format found in the SIT.  For users seeking more information on GHG 
emission estimation methodologies, refer to the State Inventory Tools and User’s 
Guides, and EPA’s U.S. Inventory of Greenhouse Gas Emissions and Sinks. EPA 
recognized that methodologies outlined in the State Guidance were lengthy and 
complex, and projecting emissions based on these methodologies further increased 
the required resources.  The Projection Tool was developed with the purpose of 
reducing the time and resources necessary to project state greenhouse gas emissions.  
By reducing the time and budget barriers that states face in developing projections, 
the Projection Tool encourages states to estimate their future emissions using the best 
widely available methodologies and data sources. The Projection Tool allows for states 
to estimate projected emissions at a high-level and provides information to states 
looking to calculate a rough estimate by sector. The tool should not be used for 
regulatory compliance, as it is an estimation tool and more rigorous calculations should 
be applied for regulatory analyses.  

 
1 See Section 1.4 for information on obtaining the Projection Tool, the State Inventory Tool 
(SIT), and the State Guidance. 
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The Projection Tool was developed with the following goals in mind:  
1) Allow states to analyze their emission trends between 2022 and 2050, with the 

additional option to analyze trends between 1990 and 2050; 
2) Allow states to easily import data from the SIT so that states can take 

advantage of existing inventory estimates;  
3) Provide default data wherever possible while still allowing states to enter their 

own data; 
4) Be as user-friendly as possible without sacrificing functionality; and 
5) Provide high-level estimation methodologies so that states can develop a rough 

estimate by sector. 
Because this is a model for projecting emissions, there are some inherent limitations 
of the tool. These limitations are discussed further in section 1.1.3. 

1.1.1 SECTORS AND DATA PRESENT IN THE PROJECTION TOOL 

The Projection Tool covers all major emissions sectors present in the State Guidance 
and the Inventory of U.S. Greenhouse Gas Emissions and Sinks.  Because data inputs 
and calculation methodologies vary among the different sectors, and sometimes 
among different subsectors, the Projection Tool is divided into 20 different sections.  
Each section differs in the amount of default data available, the ability to automatically 
import data from the SIT, and the options for inputting or forecasting data.  These 
sections, and their corresponding data inputs, are described in Figure 1. 

1.1.2 METHODOLOGIES EMPLOYED BY THE PROJECTION TOOL 

The Projection Tool forecasts emissions in one of two ways:  

1) Forecasting Activity Data. Activity data are forecasted based on historical 
activity data or obtained from publicly available forecasts (i.e., Census reports, 
the Energy Information Administration’s Annual Energy Outlook), and future 
emissions are in turn calculated using this predicted activity data; or  

2) Forecasting Emissions. Historical emissions are estimated based on known 
activity data, and future emissions are then forecasted based on this historical 
trend.  
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Figure 1: Projection Tool Sections and Data Options 
Input 

Worksheet 
Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
1 FF Consumption Not necessary Based on EIA 

regional 
projections and 
2021 state-level 
consumption (see 
Box 1 for 
description of the 
methodology) 

No auto import Not necessary User may enter 
non-SIT data 

 Wood and Waste Not available Not available No auto import User may enter 
historical data to 
project future 
data. Historical 
data can be 
found in the Bulk 
Data worksheets 
in the CO2FFC 
and/or the 
Stationary 
Combustion 
module.  

User may enter 
data for 2022 to 
2050 or use a 
linear trend of 
historical data 
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Input 
Worksheet 

Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
2 Population US Census data US Census 

projections for 
2025 and 2030; 
interpolated for 
other years. 
2031 to 2050 
population data 
is based on 
national 
projections from 
U.S. Census 
Bureau, 
apportioned to 
states based on 
2030 

No auto import User may enter 
non-SIT data 

User may enter 
non-SIT data 

Gross State Product 
(GSP) 

US Census data 
1990 to 2021 

Projected based 
on historical 
values 

No auto import User may enter 
non-SIT data 

User may enter 
non-SIT data 

3 Livestock Not necessary Based on USDA 
national 
projections and 
state populations 
in 2021 

No auto import Not necessary User may enter 
non-SIT data 

4 CO2 from fossil fuel 
consumption 

Not available Fossil fuel 
consumption 
(entered 
elsewhere) is 
multiplied by 
default emission 
factors 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emissions 
forecasts 
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Input 
Worksheet 

Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
5-6 Stationary N2O and CH4 Not available Fossil fuel 

consumption 
(entered 
elsewhere) is 
multiplied by 
default emission 
factors 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emissions 
forecasts 

7 Electricity Consumption Not available Based on EIA 
regional 
projections and 
2021 state-level 
consumption (see 
Box 1 for 
description of the 
methodology) 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emissions 
forecasts 

8 Mobile N2O and CH4 Not available State-level 
defaults 
calculated using 
data from FHWA, 
EIA 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emissions 
forecasts 
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Input 
Worksheet 

Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
9 Coal Mining and 

Abandoned Coal Mines 
Coal Mining: 
National 
emissions 
multiplied by 
state's share of 
national 
emissions 
(determined by 
SIT default 
values) 
Abandoned Coal 
Mines: Based on 
state default 
data  

Coal Mining: 
National 
projections 
multiplied by 
state's share of 
national 
emissions 
(determined by 
SIT default 
values) 
Abandoned Coal 
Mines: Based on 
future 
calculations of 
state default data 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emissions 
forecasts 

10 Natural Gas and 
Petroleum Systems 

Natural Gas and 
Petroleum 
Systems: 
National 
emissions data 
multiplied by 
state's share of 
national 
emissions 
(determined by 
SIT default 
values) 

Natural Gas: 
Implied emission 
factor multiplied 
by projected 
consumption 
Petroleum 
Systems: 
National 
projections 
multiplied by 
state's share of 
national 
emissions 
(determined by 
SIT default 
values) 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emissions 
forecasts 
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Input 
Worksheet 

Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
11 Industrial Processes Not available State-level 

defaults provided 
for ODS 
Substitutes and 
Electric Power 
Systems, all 
other sectors 
projected using a 
linear trend of 
historical data 
entered by the 
user. 

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other emissions 
forecasts 

12 Enteric Fermentation Not available Default emission 
factors are 
provided and 
multiplied by 
projected 
livestock 
population 
(entered 
elsewhere) 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emission 
factors 

13 Manure Management Not available Default emission 
factors are 
multiplied by 
projected 
livestock 
population 
(entered 
elsewhere) 

User may import 
historical 
emissions for 
comparison 
purposes 

User may enter 
non-SIT 
historical 
emissions data 
for comparison 
purposes 

User may enter 
other emissions 
forecasts 
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Input 
Worksheet 

Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
14 Rice Cultivation Default 

emissions based 
on US EPA data 

Projected 
emissions are 
based on USDA 
forecasts 

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other emissions 
forecasts 

15 Ag Soils Default 
emissions based 
on US EPA data 

Default 
projections are a 
linear trend of 
historical data 

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other emissions 
forecasts 

16 Liming Default 
emissions based 
on US EPA data 

Default 
projections are a 
linear trend of 
historical data 

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other emissions 
forecasts 

17 Urea Default 
emissions based 
on US EPA data 

Default 
projections are a 
linear trend of 
historical data  

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other emissions 
forecasts 
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Input 
Worksheet 

Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
18 Ag Residue Burning Default 

emissions based 
on US EPA data 

Default 
projections are a 
linear trend of 
national historical 
data multiplied 
by the state 
proportion of 
national 
emissions in 
2021. 

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other emissions 
forecasts or 
project using a 
linear trend of 
historical state 
data 

19 State Waste Disposal Calculated based 
on EPA data and 
user inputs on 
waste control 
worksheet 

Calculated based 
on EPA data and 
user inputs on 
waste control 
worksheet. 
Emissions 
calculated using 
the first-order 
decay model. 

No auto import User may enter 
non-SIT 
historical data 

User may enter 
other emissions 
projections or 
use a linear 
trend of 
historical data 

 

20 Flaring and LFGTE Calculated based 
on EPA data 

Calculated based 
on EPA data 

No auto import User may enter 
non-SIT 
historical data 

User may enter 
other emissions 
data and 
projection 

21 Waste Combustion Defaults equal 
national 
emissions for 
historical 
multiplied by a 
state's proportion 
of national 
population 

Default 2022 to 
2050 projections 
are a linear trend 
of national 
historical data 
multiplied by the 
state proportion 
of national 
population in 
2021 

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other projected 
data or use a 
linear forecast of 
historical data 
entered 
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Input 
Worksheet 

Number 

Projection Tool 
Section 

Default Data Data Import 
Options 

User Data Input Options 

Historical Projected From SIT Historical Projected 
22 Wastewater Defaults equal 

national 
emissions for 
historical 
multiplied by a 
state's proportion 
of national 
population 

Default 2022 to 
2050 projections 
are a linear trend 
of national 
historical data 
multiplied by the 
state proportion 
of national 
population in 
2021 

User may import 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
non-SIT 
historical 
emissions data 
to be projected 
using linear 
trend 

User may enter 
other projected 
data or use a 
linear forecast of 
historical data 
entered 

 



Projecting Greenhouse Gas Emissions using the Projection Tool                                 January 2024 

Projection Tool User’s Guide  1.11 

Details of the methodology used in each section of the Projection Tool can be viewed by 
clicking the yellow button “Click Here for Description of the Projection Methodology,” which is 
located on all the data input worksheets.  Users will notice that some sectors employ much 
more detailed estimation techniques than others.  The level of effort spent to forecast 
emissions for a given source was dictated by a) the magnitude of the source (i.e., the effort 
expended to collect data and implement projection methodologies was proportional to the 
magnitude of emissions from each source), b) the availability of activity data, and c) other 
resource constraints. 

 
 
 

1.1.3 Limitations of the Projection Tool 

Although the Projection Tool was designed to be as accurate and comprehensive as possible, 
there are several limitations to the tool design.  These limitations are discussed below. 

Historical Estimates 

The projection tool is not intended to estimate historical emissions.  Some sectors of the 
Projection Tool contain sufficient default data to back-cast emissions (i.e., to estimate 
emissions before 2022); however, these estimates are only intended to provide a rough 
comparison of historical and projected emission trends.  There is a large degree of uncertainty 
associated with these “historical” estimates, as calculated in the projection tool.  In addition, 
several sectors of the Projection Tool do not contain sufficient data to estimate historical 
emissions.   

Default Activity Data 

The Projection Tool contains a large amount of default activity data.  These data allow states 
to estimate greenhouse gas emissions even when they are unable to obtain the required data 
from in-state sources.  However, EPA encourages users to be discriminating when selecting 

Box 1: Projecting Energy Consumption Estimates 

The Projection Tool utilizes the Energy Information Administration’s (EIA) State Energy 
Data in combination with EIA’s Annual Energy Outlook, in order to arrive at state-level 
energy consumption estimates. A companion Energy Consumption Projections Excel file 
is available to assist with projecting energy consumption by state. Results from this 
Excel file can be copied and pasted into the Projection Tool. 
 
To estimate projected energy consumption, the following tables are downloaded from 
EIA: 
 

1.       EIA’s Annual Energy Outlook- Supplemental tables for Regional Detail 
2.       EIA’s State Energy Data- State consumption tables in BTU (at the bottom 

of the page, expand “Data Files” and download “All Consumption 
Estimates in Btu”): http://www.eia.gov/state/seds/.  

 
The energy consumption for each region in the Annual Energy Outlook is disaggregated 
to state-level estimates by applying the state’s proportion of consumption in 2020 from 
EIA’s State Energy Data, to future consumption from the Annual Energy Outlook out to 
2050. Energy consumption projections remain in Btu, whereas electricity consumption 
estimates are converted to kWh. The electricity consumption estimates are then 
multiplied by the most recent emission rate and grid loss factors available from eGRID. 

http://www.eia.gov/state/seds/
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default data.  Although these data may be provided at the state level, they are often taken 
from national sources and are associated with a large degree of uncertainty.  In addition, 
attempts to account for future changes in activity – such as changes in economic, political, or 
social situations that may affect the consumption of certain fuels, livestock population, etc. – 
are based on highly uncertain assumptions.  State experts should always try to review the 
default data to ensure that it is consistent with or superior to any other state-generated data. 

User-Entered Data 

While the Projection Tool describes the methodology and default data used to project 
emissions, it does not provide suggestions for obtaining state-specific activity data.  For 
suggested resources for activity data, users should consult the recommended data sources 
presented in the SIT and data sources in EPA’s Inventory of U.S. Greenhouse Gas Emissions 
and Sinks.  These data sources are only recommendations, and users will likely need to tailor 
their data gathering strategies based upon available state-specific resources. 

Equations 

In order to streamline the Projection Tool as much as possible, most of the calculations are 
not visible.  However, summaries of the methodologies can be viewed by clicking on the 
yellow ovals in the top right-hand corner of each worksheet. 

1.2 USING THE PROJECTION TOOL 

This section provides an overview for using the Projection Tool and provides an example from 
the Natural Gas and Petroleum Systems worksheet.  Although EPA attempted to make the 
input worksheets for each section consistent, differences in input data and methodologies 
necessitate variations on each worksheet.  Because the input worksheets are sufficiently 
similar between worksheets, a step-by-step explanation for each sector is not necessary.  

1.2.1 Getting Started 

The Projection Tool was first developed using Microsoft® Excel 2000.  While the module will 
operate with older versions of Excel, it functions best with Excel 2000 or later.  If you are 
using Excel 2007 or later, instructions for opening the module will vary as outlined in the 
Excel basics below. Before you use the Projection Tool, make sure your computer meets the 
system requirements.  In order to install and run the Projection Tool, you must have: 

• IBM-PC compatible computer with the Windows 95 operating system or greater; 

• Microsoft® Excel 1997 or greater, with calculation set to automatic and macros enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

 
Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  To check this setting, launch Microsoft Excel before opening the 
CO2FFC module.  Go to the Tools menu and select “Options...” Click on the “Calculations” 
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tab and make sure that the radio button next to “Automatic” is selected, and then click on 
“OK” to close the window.  The security settings (discussed next) can also be adjusted at 
this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu.   

Microsoft Excel Security 

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security 
set to medium (recommended) or low (not recommended).  To change this setting, launch 
Microsoft Excel before opening the Projection Tool.  Once in Excel, go to the Tools menu, 
click on the Macro sub-menu, and then select “Security” (see Figure 1).  The Security pop-
up box will appear.  Click on the “Security Level” tab and select medium.  When set to high, 
macros are automatically disabled; when set to medium, Excel will give you the choice to 
enable macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros.  Macros must be enabled in order for the Projection Tool to work.  Once they 
are enabled, the module will open to the control worksheet.  A message box will appear 
welcoming the user to the module.  Clicking on the “x” in the upper-right-hand corner of the 
message box will close it. 

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security 
Warning appears above the formula box in Excel when the Projection Tool is initially opened. 
The Security Warning lets the user know that some active content from the spreadsheet has 
been disabled, meaning that Excel has prevented the macros in the spreadsheet from 
functioning.  Because SIT needs macros in order to function properly, the user must click 
the “Options” button in the security message and then select, “Enable this content” in the 
pop-up box. Enabling the macro content for the SIT in this way only enables macros 
temporarily in Excel but does not change the macro security settings.  Once macros are 
enabled, a message box will appear welcoming the user to module.  Click on the “x” in the 
upper right-hand corner to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros.  To change the setting, first exit out 
of the Projection Tool and re-launch Microsoft Excel before opening the Projection Tool.  
Next, click on the File button in the top left of the screen. Scroll to the bottom of the menu 
and select the “Options” button to the right of the main menu. When the Excel Options box 
appears, select “Trust Center” in left hand menu of the box.  Next, click the gray “Trust 
Center Settings” button.  When the Trust Center options box appears, click “Macro Settings” 
in the left-hand menu and select “Disable all macros with notification.”  Once the security 
level has been adjusted, open the Projections Tool and enable macros in the manner 
described in the preceding paragraph. 

Viewing and Printing Data and Results 

The Projection Tool contains some features to allow users to adjust the screen view and the 
appearance of the worksheets when they are printed.  Once a module has been opened, you 
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom 
percentage or selecting one from the drop-down menu.  In addition, data may not all 
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appear on a single screen within each worksheet; if not, you may need to scroll up or down 
to view additional information. 
 
You may also adjust the print margins of the worksheets to ensure that desired portions of 
the Projection Tool are printed.  To do so, go to the View menu, click on “Page Break 
Preview” and drag the blue lines to the desired positions (see Figure 2).  To print this view, 
go to the File menu, and click “Print.”  To return to the normal view, go to the View menu, 
and then click “Normal”. 
 

Figure 2. Changing Security Settings 

 
 

 
 

 
 
Figure 3. Adjusting Print Margins 
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1.2.2 The Control Worksheet 

The Projection Tool opens to the control worksheet, which is used to navigate to the 
different worksheets in the tool.  Aside from the selection of a state, no data are 
entered on the control worksheet.  Rather, the control worksheet serves as a jumping-
off point from which users may access data input worksheets and summary 
worksheets.  The control worksheet contains a color key that describes different cells 
used throughout the tool and will assist in data entry.  On the input worksheets, the 
colors indicate the data input options explained in Figure 4 and shown on control 
worksheet in Figure 5. 

The control worksheet is organized into numbered steps.  It is important that users 
follow these steps in order, as data inputted in one step may affect data requested in 
subsequent steps. 

Figure 4: Explanation of Color-Coding Used in the Projection Tool  

(tan) Activity data that must be input by users and are used in one or more 
emission calculation worksheets. 

(yellow) Historical emissions data that must be input by the user and are used in 
calculations. 

(grey) Projected emissions. 
(white) Data or calculations that may not be changed. 

The first step is to select a state from the drop-down menu.  Selecting a state 
automatically selects the state-specific default data and emission factors, where 
available.  For the purposes of this example, North Carolina has been selected.   

Users should then click on the arrows to move through the various data input 
worksheets.  The first three input worksheets are for entering historical/projected 
activity data that will be used in calculations on one or more of the sector-specific 
worksheets.  The subsequent worksheets are the calculation worksheets, in which 
future data are entered and emissions are calculated for specific sectors.  Once the 
necessary data has been entered into each worksheet, users should return to the 
control worksheet in order to proceed to the next section.  As mentioned above, it is 
important that each worksheet is completed in order.  The following section uses the 
Natural Gas and Petroleum Systems worksheet as an example as it provides a good 
overview of the various input options users will encounter. 
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Figure 5: Projection Tool Control Worksheet 

 

1.2.3 The Calculation Worksheets 

From the control worksheet, users can click on the arrow labeled “Go to the Natural 
Gas and Petroleum Systems Sheet.”  The user will automatically be taken to the data 
input worksheet, displayed in Figure 6. 

The numbered steps in the left-hand corner of the input worksheets explain the 
necessary data inputs by the users.  Box 2 provides additional information regarding 
data entry in the Projection Tool.  Supplemental information that is used in the 
calculations, but that does not change, is also explained in the steps on each 
worksheet.  In this case, the Natural Gas and Petroleum Systems worksheet contains 
tables on historical and projected national 
emissions, as well as each state’s proportion of 
national production and consumption.  This 
information is used to calculate each state’s 
default emissions for this section. 

In some sections, users have the option of 
altering the years for which the Projection Tool 
calculates emissions.  For most sectors, the 
Projection Tool can be set to estimate emissions 
starting as early as 2001 and as late as 2021.  
Users may wish to adjust the projection years 
depending on which years they wish to import 
emissions from the SIT.  To make this adjustment, click on the gray box labeled 

Box 2: Entering Data 

Users can enter their own data in 
any tan or yellow cell.  Users may 
also choose to use imported or 
default data for specific years but 
input their own values for other 
years.  The imported or default 
data should be entered first.  
Clicking on the import or default 
buttons will reset and overwrite the 
values entered in the cells.  
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“Change Projection Year,” select the latest year for which the SIT was used, and click 
“Submit.”  The tables in the calculation worksheets will automatically adjust to reflect 
this selection.  Note that changing the projection 
year may clear data entered on the worksheet.  

Users need to enter historical state emission 
data into the yellow cells.  Users have three 
options when entering these data:  

1) manually enter the emission estimates, 

2) import estimates generated by the SIT, 
by clicking on the button “Import Historic 
Data” (see Box 3 for instructions on 
importing data), or  

3) use the tool’s default data, by clicking on 
the button “Use Default Historic Data.” 

Once historical data has been entered into the 
yellow cells, users should either manually enter 
their own emissions estimates or click on the 
“Use Default Projections” button. 

Users may clear entered and calculated data by clicking on the gray buttons labeled 
“Clear Projections” or “Clear Historic Data.” 

Once the calculations are completed on each input worksheet, users should click on 
the button in the top right corner, labeled “Return to Control Sheet.”  Users will then 
be able to proceed to the next input worksheet or to a summary worksheet. 

Some sections of the tool do not provide all three options for entering data.  In some 
cases, default data might not be available, or the sector might require data that cannot 
be imported from the SIT. 

Box 3: Importing Data 
Upon completion of each SIT 
module, users should export their 
data (see the SIT users’ guide for 
instructions), taking care not to 
modify the file in any way.  When 
users click on the “Import Data” 
buttons in the Projection Tool, they 
will be prompted to locate the 
appropriate export files.  Users 
need only to locate and open this 
file (following the prompts), and 
the data will be automatically 
imported into the Projection Tool. 
 
Be sure to use the latest version of 
each SIT module with the latest 
version of the Projection Tool so 
the data can be imported correctly.    
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Figure 6: Natural Gas and Petroleum Systems Data Input Worksheet 

 
 

1.2.4 The Projection Methodologies Worksheet 

In the top right-hand corner of each input worksheet, there is a yellow oval prompting 
users to “Click here for a description of projection methodology.”  Clicking on this 
button will take users to another worksheet that details the methodologies and data 
sources used to project emissions in all sectors, as shown in Figure 7.  Users may then 
click on the “Return” button to be taken back to the input worksheet. 
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Figure 7: Projection Methodologies Worksheet 

 
 

1.2.5 The Summary Worksheet 

Once all data input worksheets have been completed, users can access the summary 
worksheets from the control worksheet.  Step 6 on the control worksheet gives users 
the option of viewing results by gas type, by economic sector, or emissions intensity 
(i.e., emissions per gross state product).  These worksheets contain tables 
summarizing the state’s historical and projected emissions, as well as various charts 
that allow users to easily compare emissions from different gases and sectors.  The 
sector summary worksheet for North Carolina, using all default data, is shown in Figure 
8 (no emissions are estimated for sectors for which default data is unavailable).  
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Figure 8: North Carolina Summary Worksheet by Sector 
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1.3 FREQUENTLY ASKED QUESTIONS 

1. For which years does the Projection Tool estimate emissions? 

Users may obtain a complete time series of emissions from 1990 through 2050 
from the Projection Tool. 

For most sectors, the Projection Tool has the capability of estimating emissions as 
early as 2001.  However, users may adjust the Projection Tool so that it begins 
estimating emissions as late as 2026. 

The Projection Tool can also estimate historical emissions using linear trends of 
calculated emissions.  However, the methodologies used to estimate historical 
emissions are associated with a large degree of uncertainty; therefore, these 
historical estimates should be used for comparison purposes only.  Users are 
strongly encouraged to use the SIT to develop more accurate historical estimates. 

2. What system requirements do I need to run the Projection Tool? 

An IBM-PC compatible computer with the Windows 95 operating system or later, 
Microsoft® Excel 1997 or later, and a hard drive with at least 20MB free.  It is 
recommended, but not necessary, that users have Windows 2000 or later and Excel 
2000 or later. 

3. When I click on the buttons, nothing happens.  Why? 

When opening the file, be sure to enable macros.  Macros must be enabled in order 
for the modules to work. 

4. Is it possible to view the calculations used to estimate emissions? 

Unfortunately, most of these calculations are not explicitly displayed in the 
Projection Tool.  However, the “Projection Methodology” page explains the 
methodologies used to determine emissions. 

5. I have not used the SIT to estimate my historical emissions.  Is it still possible to 
develop a comprehensive projections inventory for my state? 

Yes.  However, it will be necessary to manually input historical emission estimates 
for certain source categories, since some projected emissions are based on these 
estimates and default data are not always available.  If no historical data are 
available, projection estimates can still be completed; however, emissions from 
some sources will not be calculated. 

6. Why is the Projection Tool unable to import my data files? 

If you have added rows or columns, moved any of the cells, or otherwise altered 
any export files, the Projection Tool may not be able to import the data.  It is 
recommended that the modules’ summary pages, and not the export files, be used 
to view results; these results may be copied into another workbook and 
manipulated by users as needed. 
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7. I successfully imported a data file, but it looks like some of the data are missing or 
in the wrong cells.  

When importing the data file for each source, be sure to select the file specific to 
the source you are trying to import.  Try importing the file again and be sure to 
select the appropriate data file. 

Also be sure to use the latest version of the SIT modules with the latest version of 
the Projection Tool. Rows in a previous version of the SIT may not align with rows 
in the latest Projection Tool due to the addition of new source categories. Use the 
latest version of each SIT module with the latest version of the Projection Tool so 
the data can be imported correctly.  

The latest SIT modules and Projection Tool are available online at:  
https://www.epa.gov/statelocalenergy/download-state-inventory-and-projection-
tool.  

8. I successfully imported data for some years, but the cells for the later years are 
blacked out.  Why? 

The Projection Tool might be set to project emissions for years for which you’d like 
to import SIT estimates.  Adjust the years for which the Projection Tool calculates 
emissions (see Section 1.2.3) and import the data again. 

9. I completed my emissions projections using data from the SIT, but have since 
updated the SIT.  Will the Projection Tool update automatically?  

No.  In order to include the updated values in the Projection Tool, you must create 
a new export file from the SIT.  Re-open the Projection Tool and import the newly 
export data file.  The new results will replace the old ones.  

1.4 FOR MORE INFORMATION 

For questions regarding these tools, or to request additional information, please 
contact: 

 Andrea Denny 
 202-343-9268 
 Denny.Andrea@epa.gov 

  
 

 

https://www.epa.gov/statelocalenergy/download-state-inventory-and-projection-tool
https://www.epa.gov/statelocalenergy/download-state-inventory-and-projection-tool

	1.1 Introduction to the Projection Tool
	1.1.1 Sectors and Data Present in the Projection Tool
	1.1.2 Methodologies Employed by the Projection Tool
	1.1.3 Limitations of the Projection Tool
	Historical Estimates
	Default Activity Data
	User-Entered Data
	Equations

	1.2 Using the Projection Tool
	1.2.1 Getting Started
	Microsoft Excel Settings
	Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to automatic calculation.  To check this setting, launch Microsoft Excel before opening the CO2FFC module.  Go to the Tools menu and select “Options...” Click on the “...
	Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make sure that the box next to the “Automatic” option is checked from the pop-up m...
	Microsoft Excel Security
	Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security set to medium (recommended) or low (not recommended).  To change this setting, launch Microsoft Excel before opening the Projection Tool.  Once in Excel, go to the To...
	When Excel security is set to medium, users are asked upon opening the module whether to enable macros.  Macros must be enabled in order for the Projection Tool to work.  Once they are enabled, the module will open to the control worksheet.  A message...
	Excel 2007 and Later: If Excel’s security settings are set at the default level a Security Warning appears above the formula box in Excel when the Projection Tool is initially opened. The Security Warning lets the user know that some active content fr...
	Viewing and Printing Data and Results

	1.2.2 The Control Worksheet
	1.2.3 The Calculation Worksheets
	1.2.4 The Projection Methodologies Worksheet
	1.2.5 The Summary Worksheet
	1.3  Frequently Asked Questions
	1.4 For More Information

